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About 
Site Mapper can be used to create and export multiple maps based on an “site” index (parent) table. You 

can create any number of maps, from just a few to 1000s.  

The site index layer can be a point, line or polygon layer. Maps can be exported to JPGs, PNGs, or PDFs. You 

can choose the PDF driver or output image resolution. 

You can also create new map or layout windows and keep these on screen to check these before printing. 

New in this release is support for two maps in layouts. This allows you to have a detailed map as well as an 

overview map. 

The selected site ID column from the site layer doesn’t have to hold unique values. Site Mapper will include 

all records with the same site ID on the map. This is useful if your table holds multiple records for each site. 

You do however need to make sure these records aren’t spread to wide so that they don’t fit on the map. 

How to use Site Mapper 
Firstly, you’ll need to first create a template map which will be used to generate the individual maps. The 

template can be either a Mapper window or Layout window (Layout windows must contain at least one 

Mapper frame). The mapper must also contain the index site layer and should also contain any other 

background layers required.  

If using a Layout window as the template, then you can also include layout frames such as title text, north 

arrow, images (e.g. logos) and legend items for the map. 

Next click on the Site Mapper button that appears on the Handy Tools tab, the Home tab and/or the 

Layout tab. 

 

This will open the Site Mapper – Batch Printing Tool dialog. This is where you configure your batch 

printing. 

We will go through the different areas of the dialog below. 



 

When you click on the OK button, the batch printing process will begin. The output will depend on the 

configurations you chose. 

Also notice that Site Mapper will remember the settings across settings. All settings but the windows and 

site layer and columns will be remembered. 

Template Window 

 

In the Template Window group, you can select the type of window to use as your template window. 

Note that the Export mapper or layout option will be disabled if you only have one window type open. 

The list Select template window lets you select the window to use from a list of open windows of the given 

type. 

Layout Map Windows 

 



If you selected a layout as your template window, you will have to select which embedded maps to use. 

Note that you can now select a Main Map and a Secondary Map. 

The Main Map is, as the name says, the main or primary map. It’s from the map that you select the layer 

you want to loop through to create your batch printing. 

The Secondary Map would typically be an overview map that can be controlled by the first map. You can 

also specify that the Secondary map keeps it initial zoom and center. 

Sites Layer – Primary Map 

 

When you have selected either your template window as a map or the primary map window in your layout, 

the list Site Layer will get populated with the possible layers from the selected map window. 

Next specify the index site layer (“parent” layer). For example, you may have a site table with 150 suburb 

boundaries. 

Now select the Site ID Column too. The Site ID column should identify the records that should be included 

on each map. 

Site Mapper will group the selected layer by the selected column and so calculate the number of maps to 

create. One map can hold multiple records from the Site Layer. Do make sure that these are close enough 

to fit on the maps you are creating. 

The values from the Site ID Column will be used to select the records from the Site Layer for each map. 

These values will also be used to select the records from a potential secondary site layer. In many cases the 

two site layers will point to the same table but that might not always be the case. 

If you check the option Check for non-unique values in Site ID Column, Site Mapper will make sure all the 

values in the selected Site ID column are unique. If they aren’t you will be prevented from continuing. This 

check helps you ensure you only have one record for each value if that is how your data has been arranged. 

Now, choose whether to add each site record (e.g. each individual suburb area) as a new query layer 

(“child” layer) in the mapper. Doing this will allow the site feature (e.g. suburb boundary) to be highlighted 

on the map. You can choose whether to use the same style override symbology and label properties for the 

child layer as has been specified for the parent layer. The child layer will also be added to the new map in 

the same position in the layer order as the parent layer. If you have not already turned off the parent layer, 

you can set the tool to turn it off. 



Map Pan and Zoom Settings – Primary Map 

 

Next specify how you want the tool to set the extents of the primary maps. You can have the tool pan or 

zoom the map to the child layer.  

The tool can pan the map to the center of the MBR (Minimum Bounding Rectangle) for each site and keep 

the current zoom or change the zoom to a specified value. If the child layer contains polygons, polylines or 

multiple records, the tool can zoom the map to the full extent of each site object (e.g. zoom to the extent 

of each suburb boundary). 

The zoom width in Zoom width, km is the current zoom of the map. If you check Current zoom, the zoom 

will not change. 

Alternatively, the tool can keep the current map extent. For example, you have a map of an entire country 

and you want to create individual maps which highlights each state/province in the country without 

changing the original extent. 

Output Settings 

 

Now specify the output settings. First you can choose between three ways to name the resulting files. You 

can use the Site ID, the counter or a separate character column. Any of these can be converted to proper 

case if required. 

Choose the output format and output folder path.  

For JPG/PNG files, you can set the output resolution.  

For PDF files, you can choose between the MapInfo PDF driver, Microsoft Print to PDF or Adobe Acrobat 

driver (if installed). At this time, these drivers are hardcoded in the MapBasic code, but can be changed by 

editing the code. If required, we can add additional PDF Driver but let us know via GitHub (see under 

Further Development) or add these yourself via the source code. 

You don’t have to create any output files. For this work, you do however need to check the option Clone 

main window for each ‘child’ site. 



Sites Layer – Secondary Map 

 

If you have selected a secondary map, you must now select the secondary site layer. If you don’t select any, 

the secondary map will not show any records highlighted and the secondary map will not change to reflect 

the current child site. 

The secondary site layer can be the same layer/table as the primary site layer. But it can also be a different 

table.  

The zoom and pan of the map will be controlled by the selected ‘child’ site from the primary site layer. 

You will also have to select a Site ID Column too. The values from the primary Site ID Column will be used 

to select the records from the secondary Site Layer for each map. 

Now, choose whether to add each site record (e.g. each individual suburb area) as a new query layer 

(“child” layer) in the mapper. Doing this will allow the site feature (e.g. suburb boundary) to be highlighted 

on the map. You can choose whether to use the same style override symbology and label properties for the 

child layer as has been specified for the parent layer. The child layer will also be added to the new map in 

the same position in the layer order as the parent layer. If you have not already turned off the parent layer, 

you can set the tool to turn it off. 

Map Pan and Zoom Settings – Secondary Map 

 

Next specify how you want the tool to set the extents of the primary maps. You can have the tool pan or 

zoom the map to the child layer.  

The tool can pan the map to the center of the MBR (Minimum Bounding Rectangle) for each site and keep 

the current zoom or change the zoom to a specified value. If the child layer contains polygons, polylines or 

multiple records, the tool can zoom the map to the full extent of each site object (e.g. zoom to the extent 

of each suburb boundary). 

The zoom width in Zoom width, km is the current zoom of the map. If you check Current zoom, the zoom 

will not change. 

Alternatively, the tool can keep the current map extent. For example, you have a map of an entire country 

and you want to create individual maps which highlights each state/province in the country without 

changing the original extent. 



Clone Main Window 

 

If you check this option Site Mapper can create new map or layout windows for all the sites in your site 

layer. This is useful if you have a few sites that you want to validate before printing, or if you want to 

manually modify these slightly before printing. 

Note that certain dynamic texts in your layout will have been converted to static texts as a dynamic text 

referring to a child site would fail to read the right values from the child site. 

Delays 

 

There is an option at the end to add a short delay (e.g. 2 seconds) before moving on to the next site. This is 

to allow the PDF driver time to finish exporting the map. This appears to have been an issue in the past, 

where the tool may crash part way through batch printing. 

Similar you can also add a delay before printing to allow MapInfo Pro to finish rendering the windows. This 

can be used if you experience issues with images or PDF files not been completely rendered. 

Preferences 
You can access the Preferences dialog for Site Mapper via the context menu of the tool by right-clicking on 

Site Mapper in the Tools window. 



 

The Preferences dialog lets you control where you want 

the display the Site Mapper control on the Ribbon. You 

can add it to the Home tab, the Layout tab and to a 

custom tab of your choice. 

By default the Custom tab is Handy Tools which has been 

the default tab for Site Mapper. 

You can control the Caption (the name displayed) as well 

as the internal name of the Tab and Tab Group where you 

want to display the Site Mapper control. 

You can also control if you want to add log messages to 

the Message window and/or to the Log file using the two 

checkboxes at the bottom of the dialog. 

 

Adding Site Values to the Layout 
If using a Layout window as the template, you can set whether to update one or more text frames on the 

layout window (such as the map title). As well as the title text, the Layout window could include text frames 

with site statistics or details. Right click on the empty text frames and name them with text which includes 

the column reference in the format “<COL#>”. For example, “Map of <COL1> Region”, “Population size: 

<COL2>”, etc. Note the column reference (<COL#>) is case sensitive. Make sure the empty text frame is 

large enough to accommodate the full updated text string. You can set the text style and font size for each 

empty text frame. 

Another options for adding values from the current child site to the layout has been added. Similar to 

above, you can insert a specific text string. To get the value from the column City, you can insert this string 

into the text frame: $mb{SMGetSiteValue("City")}. You can combine this string with a static text 

too: City: $mb{SMGetSiteValue("City")}. 



 

If you run into issues using this method, try using the additional method that will show potential errors: 

$mb{SMGetSiteValueErr("City")}. 

Do note that this alternative method, require you to insert the text in the text frame itself, not as the name 

of the text frame. 

Troubleshooting 
There is a known issue where dynamic labels which have been included in the template do not get printed 

in the output files. This issue was fixed in MapInfo Pro v17.0.3 (2019). 

Further development 
We have a list of further things we want to add to Site Mapper. 

• Support for setting cartographic scale in addition to map zoom 

• Remember earlier selected map frames, tables and columns – they are now captured and stored but 
not used when opening the dialog 

• Split the dialog into two: One for the primary map, and one for the secondary, when needed 

• Switch to using Layer Filter for MapInfo Pro v2021 

• Automatically match second site table to first site table if possible 

• Option to not use site table in the second map. Potentially allow the query from the primary map to be 
added to the secondary map too. 

• Add zoom/pan type for the second map to use first site table 

• Add option to show extent of first site map on the second site map 

• Add an option to print or export all open layout windows. 

• Let the user select from a list of values what value to use as start value and be able to specify the 
number of sites to process. Or specify an interval of sites to process, say 1-99. 

 

If you have further ideas, you can add these as issues on GitHub where you also can find the source code: 

github.com/PeterHorsbollMoller/mbSiteMapper. 

https://github.com/PeterHorsbollMoller/mbSiteMapper

